
A
H

AT
AT
T-8800 Series Switch

ardware Reference

-8824 
-8848



AT-8800 Series Hardware Reference
Document Number C613-03066-00 REV E.

© 2005 Allied Telesyn Inc. All rights reserved. No part of this publication may be 
reproduced without prior written permission from Allied Telesyn Inc.

Allied Telesyn Inc. reserves the right to change specifications and other information in 
this document without prior written notice. The information provided herein is subject 
to change without notice. In no event shall Allied Telesyn Inc. be liable for any 
incidental, special, indirect, or consequential damages whatsoever, including but not 
limited to lost profits, arising out of or related to this manual or the information 
contained herein, even if Allied Telesyn Inc. has been advised of, known, or should have 
known, the possibility of such damages.

All company names, logos, and product designs that are trademarks or registered 
trademarks are the property of their respective owners.



Hardware Reference 3
Contents
Models Covered By This Reference ....................................................................  4
Why You Should Read This Reference ...............................................................  4
Hardware Description .......................................................................................  5

Switch Overview .........................................................................................  5
AT-8800 Series Switch Models ....................................................................  7
AT-8824 .....................................................................................................  7
AT-8848 .....................................................................................................  7

Online Documentation ......................................................................................  8
Accessing the CD-ROM and Online Documentation ....................................  8

AT-TFTP Server ...................................................................................................  8
Using Windows Terminal and Hyperterminal ...................................................  10
Switch Start-up ............................................................................................... 13

To log In ................................................................................................... 13
To access help .......................................................................................... 14
Start-up Procedures ..................................................................................  14

RS-232 Terminal Port (ASYN0) ......................................................................... 17
Useful Cables ..................................................................................................  18

RS-232 Terminal and Modem Cables ........................................................  18
Cables for RJ-45 Ethernet LAN Interfaces .................................................. 19

Test Facility .....................................................................................................  21
Ethernet LAN Port Tests ............................................................................ 22
Other Interface Tests ................................................................................. 23

Redundant Power Supply (RPS) ....................................................................... 23
AT-RPS8000 ..............................................................................................  24

Port, Connector, and Cable Combinations ...................................................... 26
Troubleshooting ..............................................................................................  26

LEDs and What They Mean ....................................................................... 26
Check these first ...................................................................................... 27
Some common problems and how to solve them .....................................  28

Expansion Options .......................................................................................... 29
Gigabit Interface Converters (GBICs) ......................................................... 29
Dual In-line Memory Modules (DIMMs) .....................................................  30

Where To Find More Information ....................................................................  31
Contacting Us ................................................................................................. 31
C613-03066-00 REV E



4 AT-8800 Series Switch
C613-03066-00 REV E

Models Covered By This Reference

This Hardware Reference includes information on the following products:

■ AT-8824

■ AT-8848

The latest AT-8800 Series Hardware Reference can be found at 
www.alliedtelesyn.com/support/software

Why You Should Read This Reference

This Reference provides hardware related information for AT-8800 Series 
switches.

The Reference has two primary aims:

1. To familiarise you with the hardware features of AT-8800 Series switches.

2. To assist you with setting up and maintaining your AT-8800 Series switch. 

This Reference does not cover software configuration or software installation 
procedures. For information on software, refer to the AT-8800 Series Software Reference.

AT-8800 Series

Printed Acrobat PDF Website

Documentation Roadmap

AT-8800 Series Safety and Statutory Information Booklet

AT-8800 Series Software Reference

AT-8800 Series Hardware Reference

General Customer Support

Visit www.alliedtelesyn.co.nz for 
the latest documentation, FAQs, 
and support information.AT-8800 Series Quick Install Guide

http://www.alliedtelesyn.com/support/software
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Hardware Description

This section provides an overview of hardware features for the AT-8800 Series, 
as well as hardware descriptions of each model. 

Switch Overview
Developed to meet the exceptionally high performance demands of low to 
mid-range applications, AT-8800 Series switches deliver hardware-based low-
latency high-bandwidth wire speed Layer 2 and 3 switching, in a robust 1U 
platform.

With GBIC and 10/100BASE RJ-45 port options bridging traditional copper/
fibre divides, and hardware expansion options such as Dual In-line Memory 
Modules (DIMMs), the AT-8800 Series is a versatile and powerful switching 
solution for rapidly evolving networks.

Dimensions 

Mounting System

• 1U rack mounting

Environmental Conditions

• Operating temperature range: 0 to 50º C (32 to 122º F) 

• Storage temperature range: -20 to 60º C (-4 to 140º F)

• Relative humidity range: 5 to 95% non-condensing

Regulatory Standards

AC models

• AS/NZS3260

• CNS 13438 Class A

• BSMI

• VCCI Class A

• EMC: EN55022 class A, FCC class A, and VCCI class I

• Immunity testing to EN55024: EN61000-3 levels 2 (Harmonics), and 3 
(Flicker). EN61000-4 levels 2 (ESD), 3 (susceptibility), 4 (fast transients), 
5 (power surge), 6 (RF immunity), and 11 (Voltage dips and sags). 

• Safety: UL60950, CAN/CSA-C22.2 NO. 60950-00, EN60950, ACA TS001

• Certification: UL, cUL, TUV

Table 1: Dimensions for AT-8824 and AT-8848.

AT-8824 and AT-8848

Height 1U - 44 mm (plus 5.5 mm if the rubber feet are used).

Width 440 mm (excluding rack-mounting brackets).

Depth 350 mm.

Weight Not more than 6 kg excluding power cord.
C613-03066-00 REV E



6 AT-8800 Series Switch
LEDs

• Port and System status LEDs

• For a complete list of LEDs and their functions, see “LEDs and What 
They Mean” on page 26.

Power Supply Unit

AC models

• Universal 100/240 VAC 50/60 Hz input

• Redundant DC Power connection

Maximum Current Loads

AC models

• Maximum continuous current draw, 0.7A at 240V, 1.5A at 100V

• Maximum inrush current (cold start at 25º C/77º F), 50A at 115V

Switching Cores

• Application-Specific Integrated Circuit (ASIC) switch chip

• Non-blocking L2 and L3 IP Switching

• 8 k entry forwarding address database

• 32 MByte SDRAM packet buffer

Processing Core

• 400 MHz RISC Processor

• 64, 128 or 256 MBytes Synchronous DRAM on DIMM

• 16 MBytes of fixed flash (expandable to 32 MBytes)

• 256 kBytes of SRAM (NVS)

• Battery backed real time clock (RTC)

• 32-bit/33 MHz PCI bus

• Silicon ID chip storing serial number, board ID, and MAC address

Asynchronous Serial Port

• Up to 115 kbps

• Hardware-flow control

• RJ-45 with Cisco pinout

• RJ-45 cable and RJ-45 to DB9 adapter supplied

PCI Accelerator Card (PAC) Slot 

• For optional 32-bit PCI based hardware Encryption and/or 
Compression Card, a PAC interface connection is provided
C613-03066-00 REV E



Hardware Reference 7
AT-8800 Series Switch Models
This section provides hardware descriptions for the individual switch models. 

AT-8824
(Front Panel Figure 2 on page 7, Rear Panel Figure 3 on page 7)

• 24-port 10BASE-T/100BASE-TX (RJ-45 connectors)

• 2-port 1000BASE-X (GBIC slots)

• Unrestricted 1000BASE-T GBIC use

• One DIMM socket for expansion of Synchronous DRAM to 256MB

• Compatible with AT-RPS8000 systems 

• Auto-negotiating Layer 3 Managed Switch

Figure 1: Front panel of the AT-8824.

AT-8848
(Front Pane, Figure 2 on page 7, Rear Panel Figure 3 on page 7)

• 48-port 10BASE-T/100BASE-TX (RJ-45 connectors)

• 2-port 1000BASE-X (GBIC slots)

• Unrestricted 1000BASE-T GBIC use

• One DIMM socket for expansion of Synchronous DRAM to 256MB

• Compatible with AT-RPS8000 systems 

• Auto-negotiating Layer 3 Managed Switch

Figure 2: Front panel of the AT-8848.

Figure 3: Rear panel of the AT-8800 series switches.
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8 AT-8800 Series Switch
Online Documentation

This section provides a step-by-step guide to accessing online documentation. 
Adobe Acrobat Reader must be installed to view online documentation.

Accessing the CD-ROM and Online Documentation

Follow these steps to access the CD-ROM and online documentation:

1. Insert the Documentation and Tools CD-ROM in the CD-ROM drive.

2. If the CD-ROM browser does not appear.

Select "Run" from the Start Menu (Windows 95, 98, 2000 or NT 4.0).

Type d:\start.exe (where d: is the CD-ROM drive letter) and click OK.

3. To view a document.

Click on the document title.

4. To navigate around PDF documents.

Use the toolbar buttons, keyboard shortcuts, or commands from the 
Document menu to page through the document.

Click on a bookmark, thumbnail or hypertext link to jump to a specific 
section or topic.

Use the Search command to search for keywords or phrases.

For more information about using the Adobe Acrobat Reader, select 
"Reader Guide" from the Help menu.

5. To install any of the tools included on the CD-ROM.

Click on a link in the CD browser. 

AT-TFTP Server

This section provides information on how to access and use AT-TFTP Server. 
AT-TFTP Server can be used to transfer configuration files as well as to 
download software patches and releases.

To use AT-TFTP Server, follow these steps:

1. If AT-TFTP Server has not yet been installed.

Install it now from the AT-8800 Series Documentation and Tools CD-ROM.

Choose AT-TFTP Server from the Start > Programs > Allied Telesyn > 
AT-TFTP Server menu.

2. To set preferences for the AT-TFTP Server.

Select "Options" from the File menu to display the "Set Preferences" dialog 
box.

The "Default file transfer directory" field specifies the directory that AT-
TFTP Server will read from or write to for file requests that do not include a 
directory specification.
C613-03066-00 REV E



Hardware Reference 9
To prevent unauthorised access to private directories, enter a path name in 
the "Restrict to directory" field. AT-TFTP Server will use only the specified 
directory, even if file requests contain references to other directories.

Select "Read only" to prevent files being written to the PC. To use the PC to 
archive scripts created using the switch's CREATE CONFIG command, 
select "Read Write".

Make any required changes and click "OK".

3. To load a file from AT-TFTP Server to the Switch.

On a terminal connected to the RS-232 Terminal Port (ASYN0), type the 
command:

LOAD METHOD=TFTP FILE=filename SERVER=ipadd DEST=FLASH

where filename is the name of the file to download and ipadd is the IP 
address of the PC running AT-TFTP Server.

4. To save a TFTP Server log.

Select "Save As" from the File menu.

TFTP requests are logged to the AT-TFTP Server main window.
C613-03066-00 REV E



10 AT-8800 Series Switch
Using Windows Terminal and 
Hyperterminal

You can use a PC running terminal emulation software as the manager console, 
instead of a terminal. There are many terminal emulation applications 
available for PCs, but the most readily available are the Terminal and 
HyperTerminal applications included in Microsoft Windows 98, 2000, and 
XP Professional. In standard Windows installations, HyperTerminal is 
available from the Communications submenu.

The key to successful use of terminal emulation software with the switch is to 
configure the software and switch with matching communications parameters. 
The following procedure can be applied to most terminal emulation programs. 
Dialog boxes in the procedure are from Windows 2000 and XP Professional.

To configure Windows HyperTerminal for 2000 and XP Professional

1. Start the program in Windows by doing one of the following:

• Select Programs > Accessories > Communications > HyperTerminal.

• Double-click the Hypertrm.exe icon.

2. In the Connection Description dialog box:

• Enter a name for the connection, such as Admin.

• Select an icon from the scrollable list and click the OK button.
C613-03066-00 REV E
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3. In the “Connect using” field on the Connect To dialog box, select the COM 
port on the PC used to connect to the switch. and click the OK button. 

4. In the COMn Properties dialog box, set port parameters as follows, and click 
the OK button.
C613-03066-00 REV E



12 AT-8800 Series Switch
5. From the main HyperTerminal window, select Properties from the File 
menu. Click the Settings tab, and set the Properties dialog box as follows.

6. Click ASCII Setup to display the ASCII Setup dialog box, and ensure the 
following options are not selected:

• Echo typed characters locally

• Append line feeds to incoming line ends

Set other parameters as necessary and click the OK buttons on both dialog 
boxes to close them.   
C613-03066-00 REV E



Hardware Reference 13
7. Save the current session by selecting Save from the File menu on the main 
HyperTerminal window. This creates a connection icon with the name you 
assigned in the HyperTerminal group. 

To use the configuration, double-click the connection icon. When the 
HyperTerminal window appears, press the Enter key several times; the 
switch’s login prompt is then displayed.

Switch Start-up

This section outlines the log in and start-up procedures for your switch. 
Although the switch will perform basic switching operations without being 
configured, you will need to go through these log in and start-up procedures if 
you wish to configure the switch and access its full layer 3 switching 
capabilities.

To log In
To log in you must first connect the switch to a terminal or PC. This can be 
done using the RS-232 Terminal Port (ASYN0). A terminal cable suitable for 
use with ASYN0 is supplied with each switch.

Using the supplied terminal cable, or a cable you have made by following the 
instructions in “Useful Cables” on page 18, connect your terminal or PC to 
ASYN0.

Set the communication parameters on your terminal or terminal emulation 
program to:

• Baud rate: 9600

• Data bits: 8

• Parity: None

• Stop bits: 1

• Flow control: Hardware

See “Using Windows Terminal and Hyperterminal” on page 10 for more 
information on configuring emulation software.

Ensure that any power switches are in the On position and that the switch is 
receiving power. 

After the switch has booted, the log in prompt appears. If the log in prompt 
doesn’t appear, press [Enter] two or three times.

When the switch boots for the first time it automatically creates an account 
with manager privileges. The account has the log in name “manager” and the 
password is “friend”.

At the log in prompt, enter the log in name and password.

Log in: manager

Password: friend

The switch’s command prompt appears and you can now configure the switch 
using the command line interface.
C613-03066-00 REV E



14 AT-8800 Series Switch
Change the password as soon as possible. Leaving the manager account with 
the default password is a serious security risk. Make sure that you remember 
the new password as there is no way to retrieve it if it is lost.

Use the following command to change the account password:

set password

See the AT-8800 Series Software Reference for more information on configuring 
the switch.

To access help
To display a list of help topics, enter:

help

To display help on a specific topic, enter:

help topic

Alternatively, type a question mark (?) at the end of a partially completed 
command to see a list of valid options.

Start-up Procedures
When the switch starts up following either a power cycle or an operator-
initiated reboot (using the Reset button or RESTART command), a series of 
start-up messages is sent to the terminal or PC connected to ASYN0 (Figure 4 
on page 14).

Figure 4: Switch start-up messages.

After the self tests are complete, the manager is given the option of forcing a 
mandatory boot from the EPROM (Flash) release. The message:

Force EPROM download (Y)?

is displayed on the terminal or PC connected to ASYN0 and the switch pauses. 
If a key is not pressed within a few seconds, the start-up process will continue 
and all steps in the sequence will be executed. Pressing selected keys on the 
terminal immediately after the “Force EPROM download” message is 
displayed will change the switch start-up process (Table 2 on page 15).

INFO: Self tests beginning.
INFO: RAM test beginning.
PASS: RAM test, 65536k bytes found.
INFO: BBR tests beginning.
PASS: BBR test, 128k bytes found.
INFO: Self tests complete
INFO: Downloading switch software.
Force EPROM download (Y) ?
INFO: Initial download succeeded
INFO: Executing configuration script <boot.cfg>
INFO: Switch startup complete

Manager >
C613-03066-00 REV E



Hardware Reference 15
During the start-up process the switch will generate four different types of 
messages. All messages are preceded by one of the words INFO, PASS, FAIL, 
or ERROR. The significance of these words is shown in Table 3 on page 15.

The possible messages and their meanings are:

INFO: Self tests beginning.

The code loader tests are about to begin.

INFO: RAM test beginning.

The RAM tests are about to begin.

PASS: RAM test, 65536k bytes found.

The RAM test passed, and the indicated amount of memory was found 
and will be used by the switch.

ERROR: RAM test 5. Error address = 00345678.

A RAM test failed, at the given address. In the example, it was the fifth 
test run. The RAM test repeats until it passes, so a number of messages 
like this may appear. This fault means that the memory system is faulty. 
If the fault continues, contact your authorised Allied Telesyn distributor 
or reseller immediately.

INFO: BBR tests beginning.

The BBR battery tests are about to begin.

PASS: BBR test, 128k bytes found.

The BBR size/location test passed, with the indicated amount of BBR 
found.

FAIL: BBR test. Error address = 12345678.

The BBR size/location test failed at the given location. The test at this 
location failed, indicating the end of memory, but a valid location was 
discovered in the 255 long words following this location. The BBR 
system will need to be replaced. Contact your Authorised Allied 
Telesyn distributor or reseller.

Table 2: Switch start-up sequence keystrokes.

Pressing key... Forces the switch to...

[Y] Load the EPROM release, with no patch.

[S] Start with the default configuration. Any boot script is ignored.

[Ctrl/D] Enter diagnostics mode.

Table 3: Switch start-up message classes.

Message Meaning

INFO An action will be taken by the system.

PASS A test has been completed successfully.

ERROR An error message that a test has failed, but the system will continue to 
operate.

FAIL An error message that a fatal error condition has caused the system to 
halt in an unrecoverable fashion.
C613-03066-00 REV E



16 AT-8800 Series Switch
FAIL: BBR test, only 16k bytes found.

The BBR size/location test completed, but only the displayed amount 
of memory was found. This amount is less than the minimum required 
to run the switch software.

INFO: Self tests complete.

The start-up tests have finished.

INFO: Downloading switch software.

The process of downloading the switch software and vector table from 
ROM is about to begin.

ERROR: Code load retried.

FAIL: Code load failed.

The load of the code from ROM to RAM failed. The load is retried a 
number of times. Each time a failure occurs, the ERROR message is 
displayed. If the maximum number of attempts is reached, the FAIL 
message is displayed.

INFO: Initial download successful.

The start-up tests and download are complete, and the switch software 
is about to be started. 

INFO: Executing configuration script <script-name>

The configuration commands stored in <script-name> are being 
executed. If an error is found in the script, one or more ERROR 
messages will be displayed.

INFO: Switch startup complete.

The start-up process is complete and the switch will now perform basic 
switching operations. Further configuration will be necessary if you wish to 
access the switch’s full layer 3 switching capabilities. See your AT-8800 Series 
Software Reference for detailed information on configuring the switch.
C613-03066-00 REV E
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RS-232 Terminal Port (ASYN0)

This section introduces the switch’s RS-232 Terminal Port (ASYN0), including 
its pin assignment and purpose.

The RS-232 ASYN0 Terminal Port is used to connect the switch to a 
management device for initial configuration and switch management tasks. 
This allows the switch’s software to be accessed from a terminal, or a PC 
running terminal emulation software. You can also use ASYN0 to establish a 
network connection from a remote site using SLIP and a modem.

ASYN0 has an RJ-45 socket with an industry recognised pinout. This requires 
the use of a straight-through RJ-45 cable with an RJ-45 DB9F connector when 
connecting the switch to a terminal or PC. The socket is wired as a DTE and the 
pin roles are shown in Figure 5 on page 17 and listed in Table 4 on page 17.

See “Useful Cables” on page 18 for more information on suitable cables to use 
with ASYN0. 

Figure 5: RS-232 Terminal Port Pin Numbers

Table 4: Internal DTE pin roles.

Pin Role

1 RTS

2 DTR1

1. DTR and DSR are connected together but have no other internal connection.

3 TXD

4 GND

5 GND

6 RXD

7 DSR1

8 CTS

1 8

RJPIN1
C613-03066-00 REV E



18 AT-8800 Series Switch
Useful Cables

This section describes how to make management, test, and network cables for 
use with the switch’s RS-232 (ASYN0) and RJ-45 interfaces. 

RS-232 Terminal and Modem Cables
Table 5 list the terminal and modem cables described in this section. 

Figure 6, and Figure 7 show how to wire cables to connect a standard VT100 
compatible terminal, or a modem, to ASYN0.

Figure 6: Pin wiring diagram for a standard DB9 male to female terminal cable.

Table 5: Terminal and modem cable descriptions.

Cable type Description

RS-232 RJ-45 to DB9 female terminal cable Figure 6 on page 18

RS-232 RJ-45 to DB9 male modem cable Figure 7 on page 19

Notes:
(1) → Output from switch; ← Input to switch.
(2) Cable version 1.0.
(3)            Pin 4 unconnected.

RJ-45
(to switch/DTE)

DE9 Female
(to PC/terminal/DTE)

Ciscowiredrj45db9

(DTR) 2

(RXD)
(TXD) 3

6
(DCD) 7
(GND) 5

(CTS) 8
(RTS) 1

not connected

1
2
3
4
5
6
7
8
9

(DCD)
(RXD)
(TXD)
(DTR)
(GND)

not connected

(DSR)
(RTS)
(CTS)
(RING)

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female Pin View

18

RJ-45 Pin View
C613-03066-00 REV E
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Figure 7: Pin wiring diagram for a DCE RS-232 Terminal Port (DB9 male connector) 
male to male modem cable.

More information on pin assignments for the RS-232 Terminal Port can be 
found in “RS-232 Terminal Port (ASYN0)” on page 17.

Notes:
(1) → Output from switch; ← Input to switch
(2) Cable version 1.0.

 
3 (TXD) 
2 (RXD) 
1 (DCD) 
5 (GND)
4 (DTR)
8 (CTS)
7 (RTS)
9 not connected
6 not connected

4
3
6
7
5
2
8
1

RJ-45 
(to switch/DTE)

DB9 Male
(to modem/DCE)

not connected
→ (TXD)
← (RXD)
← (CD)
    (GND)
→ (DTR)
← (CTS)
→ (RTS)
  not connected

RJ45DTEDB9Msw

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Male Pin View

18

RJ-45 Pin View
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Cables for RJ-45 Ethernet LAN Interfaces
For 10BASE-T/100BASE-TX/1000BASE-T (10/100/1000BASE) connections, a 
twisted pair cable with four pairs and RJ-45 connectors must be used. 

Table 6 on page 20 lists the cables used for network connections and testing of 
RJ-45 interfaces.

Caution. Do not plug a phone jack into any RJ-45 port. Doing so could damage 
the switch. Use only twisted pair cables with RJ-45 connectors.

Pin assignments
For twisted pair cables each pair is identified by two different colours. For 
example, one wire might be red, and the other red with a white stripe. An RJ-45 
connector must be fitted to both ends of the cable. Figure 8 on page 20 
illustrates the pin layout for RJ-45 connectors.

Figure 8: RJ-45 Pin layout. 

Table 6: Cables for RJ-45 LAN interfaces.

Purpose Interface type Cable type Pairs Pin assignment

Network 10/100/1000BASE Straight through Four Table 7 on page 21

Test 10/100/1000BASE Crossover or straight through Four Table 8 on page 21 or 
Table 7 on page 21

1
8

1
8

RJPIN
C613-03066-00 REV E
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1000BASE straight through cable
For 1000BASE network connections, all four pairs are used and the cable is 
wired in a straight-through configuration. This cable can also be used, in 
conjunction with the software test facility, to test 1000BASE network ports. 
Table 7 on page 21 lists the pin assignments.

1000BASE crossover cable
For 1000BASE test cables, all four pairs are used and the cable is wired in either 
a crossover or straight-through configuration. Table 8 on page 21 lists the pin 
assignments for a crossover cable.

Table 7: Pin assignments, 10/100/1000BASE-T RJ-45 four pair straight-through 
cable.

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 1 Pair 1+

2 Pair 1- 2 Pair 1-

3 Pair 2+ 3 Pair 2+

6 Pair 2- 6 Pair 2-

4 Pair 3+ 4 Pair 3+

5 Pair 3- 5 Pair 3-

7 Pair 4+ 7 Pair 4+

8 Pair 4- 8 Pair 4-

Table 8: Pin assignments, 10/100/1000BASE-T RJ-45 four pair crossover 
cable .

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 3 Pair 2+

2 Pair 1- 6 Pair 2-

3 Pair 2+ 1 Pair 1+

6 Pair 2- 2 Pair 1-

4 Pair 3+ 7 Pair 4+

5 Pair 3- 8 Pair 4-

7 Pair 4+ 4 Pair 3+

8 Pair 4- 5 Pair 3-
C613-03066-00 REV E



22 AT-8800 Series Switch
Test Facility

This section introduces the Test Facility. The Test Facility is built into all 
AT-8800 Series software. For detailed information on operating the Test 
Facility, see the Test Facility chapter of the AT-8800 Series Software Reference.

Any interfaces being tested are dedicated to the Test Facility. The Test Facility 
can be thought of as a specialised interface module like PPP.

Before using the test facility, disable any configurations
(SET CONFIGURATION=NONE) and restart or reboot the switch.

Ethernet LAN Port Tests
A crossover cable is required to run an Ethernet LAN test. See “Useful Cables” 
on page 18 for details of how to make a suitable cable. To start the test, loop a 
four-pair crossover or straight-through cable between any two RJ-45 ports and 
enter:

ENABLE TEST INT=ALL

A loopback plug, instead of a crossover cable, can be used to test SC and MT-RJ GBIC 
interfaces.

All interfaces connected by crossover cables are tested. Test results are 
displayed with the command:

SHOW TEST

which produces a display like that shown in Figure 9 on page 23. A more 
detailed output (with frame counts) can be displayed with the command:

SHOW TEST COUNT

which is shown in Figure 10 on page 23.

Other Interface Tests
Refer to the Test Facility of the AT-8800 Series Software Reference for 
information on testing other interfaces.

If a test fails, please contact your Authorised Allied Telesyn distributor or 
reseller.
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Figure 9: Example output from the SHOW TEST command, with a test cable between ports 1 and 4.

Figure 10: Example output for the SHOW TEST COUNT command, with a test cable between ports 1 and 4.

Board      ID  Bay Board Name                      Rev    Serial number
----------------------------------------------------------------------------
Base      148      AT-8848                         P1-0   42029694

                                              Duration       Details
Interface  State    Result              Type  (minutes)  Data( %OK )  Control
----------------------------------------------------------------------------

  port1   testing   wait 4 minutes      TP         < 1   GOOD (100.0)  -
  port2   no test     -                  -           -    -     -      -
  port3   no test     -                  -           -    -     -      -
  port4   testing   wait 4 minutes      TP         < 1   GOOD (100.0)  -
  port5   no test     -                  -           -    -     -      -
  port6   no test     -                  -           -    -     -      -
  port7   no test     -                  -           -    -     -      -
  port8   no test     -                  -           -    -     -      -
  port9   no test     -                  -           -    -     -      -
  port10  no test     -                  -           -    -     -      -
  port11  no test     -                  -           -    -     -      -
  port12  no test     -                  -           -    -     -      -
  port13  no test     -                  -           -    -     -      -
  port14  no test     -                  -           -    -     -      -
  port15  no test     -                  -           -    -     -      -
  port16  no test     -                  -           -    -     -      -

  asyn0   testing   wait 4 minutes       -         < 1    -     -      -
----------------------------------------------------------------------------

Board     ID    Bay Board Name                      Rev    Serial number
----------------------------------------------------------------------------
Base      148     AT-8848                           P1-0   42029694

                          Duration                   Frame Counters
Interface  State    Type  (minutes)         Tx    RxTotal     RxGood      RxBad
--------------------------------------------------------------------------------

  port1   testing   TP         < 1   000298842  000298841  000298841  000000000 
  port2   no test    -           -           -          -          -          -
  port3   no test    -           -           -          -          -          -
  port4   testing   TP         < 1   000298842  000298841  000298841  000000000 
  port5   no test    -           -           -          -          -          -
  port6   no test    -           -           -          -          -          -
  port7   no test    -           -           -          -          -          -
  port8   no test    -           -           -          -          -          -
  port9   no test    -           -           -          -          -          -
  port10  no test    -           -           -          -          -          -
  port11  no test    -           -           -          -          -          -
  port12  no test    -           -           -          -          -          -
  port13  no test    -           -           -          -          -          -
  port14  no test    -           -           -          -          -          -
  port15  no test    -           -           -          -          -          -
  port16  no test    -           -           -          -          -          -

  asyn0   testing    -         < 1   000000000  000000000  000000000  000000000
--------------------------------------------------------------------------------
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Redundant Power Supply (RPS)

RPS units enhance network reliability by providing backup coverage for switch 
Power Supply Units (PSUs).

AT-8800 Series switches have an RPS connector on their rear panel. The 
connector allows the switch to be used in conjunction with an RPS. 

When an RPS is required, AT-8848 and AT-8824 models use the AT-RPS8000 
system. RPS systems can be purchased separately.

AT-RPS8000
The AT-RPS8000 is a chassis that holds up to four removable AT-PWR8000 RPS 
units. To provide backup power to AT-8824 and AT-8848 switches, each switch 
must be connected to an AT-PWR8000 power unit, and the power unit must be 
installed in an AT-RPS8000 chassis.

Table 9 on page 24 lists the RPS connector’s pin numbers and pin functions, as 
found on AT-8824 and AT-8848 switches.

Table 9: RPS Connector Pin Numbers and Functions.

Pin Number Function

1 +12VDC

2 Remote Sense (RS) +5VDC

3 Remote Sense (RS) Ground

4 Remote Sense (RS) +3.3VDC

5 Redundant Power Supply (RPS) Present

6 Ground (+3.3VDC Return)

7 Ground (+5VDC Return)

8 +5VDC

9 Ground (+12VDC Return)

10 +3.3VDC

11 Ground (+3.3VDC Return)

12 +3.3VDC

13 Ground (+3.3VDC Return)

14 +3.3VDC

15 +5VDC

16 Ground (+5VDC Return)
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Table 10 on page 25 illustrates the connector’s pin layout, as found on the rear 
panel of AT-8800 series switches.

Pin 16 is at the connector’s top left, while pin 1 is at its lower right.

Specifications

Dimensions

• Height = 67 mm (plus 5.5 mm if the rubber feet are used)

• Width = 440 mm (excluding rack-mounting brackets)

• Depth = 360 mm 

• Weight = 6.76 kg with one AT-PWR8000 installed, 10.21 kg with four 
AT-PWR8000 power units installed

Mounting System

• 1.5U rack mounting

Environmental Conditions

• Operating temperature range: 0 to 50º C (32 to 122º F)

• Storage temperature range: -25 to 70º C (-13 to 158º F)

• Relative humidity range: 5 to 95% non-condensing

Regulatory Standards

• EMC: EN55022 Class A, FCC class A, and VCCI class A

• Immunity testing to EN55024, EN61000-3-2/3

• Safety: UL60950, CAN/CSA22.2, EN60950, No. 60950-00

• Certification: UL, cUL, TUV

LEDs

• AC supply to AT-PWR8000

For LED descriptions, see “LEDs and What They Mean” on page 26.

AC Power Supply

• Universal 110/230 VAC 50/60 Hz input

DC Output

• +3.3VDC/16A

• +5VDC/16A

• +12VDC/0.5A

Table 10: AT-PWR8000 RPS Connector Pin Layout.

16 15 14 13 12 11 10 9

8 7 6 5 4 3 2 1
C613-03066-00 REV E



26 AT-8800 Series Switch
Port, Connector, and Cable Combinations

This section provides cabling guidelines for each switch model.

1. Refer to the IEEE 802.3 standards for further cable information.

Troubleshooting 

This section provides information on how to detect and resolve problems with 
AT-8800 Series switches and their expansion options.

Other sources of useful troubleshooting information are:

■ www.alliedtelesyn.com/support/software

■ The AT-8800 Series Software Reference.

LEDs and What They Mean
The following tables outline how LEDs on AT-8800 switches report faults and 
operational activities.

System LEDs

Table 11: Cable guidelines for AT-8800 Series switches.

Model Port Type Connector Type Cable Type1 Maximum Cable Length

AT-8824 and 
AT-8848

10BASE-T/100BASE-TX RJ-45 CAT5

CAT5E

120 m Max

AT-8824 and 
AT-8848

1000BASE-X Varies with GBIC Refer to GBICs user 
documentation

Refer to GBICs user 
documentation

Table 12: System LEDs found on the AT-8800 Series Switch.

LED State Function

RPS (Redundant 
Power Supply)

Green An RPS is connected to the switch and is 
supplying power.

FAULT Red The switch or management software is 
malfunctioning. PSU fail.

PWR

(Power)

Green The switch is receiving power from the AC 
power source.
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Check these first
1. Check the power cord connections.

2. Check that the power supply voltage is stable.

3. Check that the correct data cables are being used and that their connections 
are secure.

4. Check that any GBICs are correctly installed and that they are compatible 
with the switch. See “Gigabit Interface Converters (GBICs)” on page 29 for 
more information.

5. Make sure that other network devices are working properly.

6. Use the SHOW INSTALL command to check that the latest software release 
is loaded. See the AT-8800 Series Software Reference for more information 
about obtaining the latest software release.

7. If the switch is malfunctioning, reboot it by pressing the recessed Reset 
button or entering the command RESTART REBOOT. Alternatively, shut 
down and restart the switch using its power switch (AC models) or 
run/standby switch (DC models).

Table 13: Port and GBIC LEDs on the AT-8800.

LED State Function

GBIC L/A

(Link activity)

Green A 1000 Mbps link is open. The link is operating 
in full duplex mode.

Flashing green 1000 Mbps full duplex activity is occurring.

Amber A 1000 Mbps link is open.

Flashing amber 1000 Mbps activity is occurring.

GBIC Green A GBIC is installed and enabled.

Amber A GBIC is installed but has not been 
recognised.

Flashing amber A GBIC is installed and enabled, but a Tx fault 
is occurring.

BASE-T L/A

(Link activity)

Green A 100 Mbps link is open.

Flashing green 100 Mbps activity is occurring.

Amber A 10 Mbps link is open.

Flashing amber 10 Mbps activity is occurring.

BASE-T D/C

(Duplex/collision)

Green The port is operating in full duplex mode.

Amber The port is operating in half duplex mode.

Flashing amber Collisions are occurring.
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Some common problems and how to solve them

Link/Activity LED on any port is off

This can indicate:

■ A loose data cable.

■ The device at the other end of the connection is not working properly or is 
turned off.

■ The data cable is not wired correctly.

■ The network administrator has manually disabled the port through the 
software.

■ The port’s selected transmission mode does not match that of the attached 
device.

Perform the following steps in sequence:

1. Make sure the data cable connections are secure.

2. Make sure the device at the other end of the connection is switched on and 
working properly.

3. Check that the data cable is wired correctly.

4. If you can, log in and check the port status. See “To log In” on page 13 for 
more information on how to log in.

5. If the port is Enabled, make sure the transmission speed matches that of the 
connected device (auto-negotiating, full or half-duplex).

If the port is disabled, someone has used the software to manually disable it. You should 
find out why the port was disabled before enabling it.

Power LED is off

This can indicate:

■ A loose power cord.

■ A power supply failure.

Perform the following steps in sequence:

1. Check that the power cord connections are secure.

2. Check that all switches and circuit protection devices are in the ON position.

3. Ensure that the supply voltage is within the operational range (100/240 
VAC 50/60 Hz for AC models).
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Fault LED is on

This can indicate:

■ There is a problem with the switch or PSU.

■ The switch or management software is malfunctioning.

■ A hardware fault is preventing switch start-up.

Perform the following steps in sequence:

1. Check “LEDs and What They Mean” on page 26 for descriptions and 
explanations of LED flashing sequences.

2. Reset the switch by pressing the recessed RESET button on the front panel.

3. If you were attempting to download software or manage the switch via the 
RS-232 Terminal Port, check that connections between the Terminal Port 
and local terminal or PC are secure.

If you cannot access the switch’s software because of a faulty RS-232 
Terminal Port connection, you can still manage the switch via Telnet or 
SNMP until the problem is fixed.

4. Download the latest software release. See the AT-8800 Series Software 
Reference for more information on how to obtain the latest software release.

Expansion Options

This section provides an overview of the expansion options for AT8800 Series 
Switches. The following expansion options were available when this Reference 
was written. See your Authorised Allied Telesyn distributer or reseller, or visit 
www.alliedtelesyn.com/support/software to see if any new options are 
available.

Gigabit Interface Converters (GBICs)
GBICs are removable gigabit port converters for switches that have GBIC bays. 
GBICs allow users to interchange port types to meet changing network 
requirements. GBICs can be purchased when a switch is purchased, or can be 
ordered separately as needed.

The following GBICs have been approved for use with AT-8800 Series switches:

■ Allied Telesyn AT-G9T

■ Allied Telesyn AT-G8T

■ Allied Telesyn AT-G8ZX      70km ZX

■ Allied Telesyn AT-G8SX       550m SX

■ Allied Telesyn AT-G8LX10   10km LX

■ Allied Telesyn AT-G8LX25   25km LX

■ Allied Telesyn AT-G8LX40   40km LX

■ Allied Telesyn AT-G8LX70   70km LX

For more information about GBICs and the latest list of approved GBICs, 
contact your authorised Allied Telesyn distributor or reseller or visitour 
website at www.alliedtelesyn.com/support/software .
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Any combination of copper and fibre GBICs can be installed in the AT-8800 
Series switches.

RX and TX terminal locations on SC fibre GBIC ports are the reverse of RX and TX 
terminal locations on fixed SC fibre ports. When looking at an SC fibre GBIC from the 
front, the RX terminal is on the left and the TX terminal is on the right.

GBIC 1000BASE-T Auto-Negotiation
1000BASE-T GBICs support only 1000 Mbps full duplex connections. Although 
1000BASE-T GBICs will participate in auto-negotiation processes, they will 
only advertise 1000 Mbps. Half duplex, 10BASE-T, and 100BASE-TX modes are 
not supported.

While 1000BASE-T GBICs will auto-negotiate at the copper Ethernet level, the 
ports will behave as if in fixed 1000 Mbps full duplex mode. This is because the 
SERDES connection used by GBIC ports makes the auto-negotiation invisible 
to the switch, and so prevents a successful link negotiation.

When a 1000BASE-T GBIC is inserted into a GBIC slot, the port’s auto-
negotiation capability is disabled. This means that the port speed may not be 
set to "auto-negotiate". If the port had been configured to auto-negotiate (by 
default or by command) prior to the GBIC’s insertion, then this configuration is 
overridden for as long as the GBIC remains in place.

Dual In-line Memory Modules (DIMMs)
Synchronous DRAM for AT-8800 Series switches is provided by a single 
DIMM. Three memory sizes are supported; 64 MBytes, 128 MBytes and 256 
MBytes. 

Only Allied Telesyn supplied DIMMS have been tested and approved for use 
with AT-8800 Series switches. Using DIMM that has not been approved may 
cause unreliable operation and will invalidate the switch’s warranty.

To check how much DIMM is installed, enter

SHOW SYSTEM

For AT-8800 Series switches, DIMMs should only be installed by authorised 
service personnel. Unauthorised opening of the switch’s lid may cause danger 
of injury from electric shock, damage to the switch, and invalidation of the 
product warranty. 
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Where To Find More Information

The Documentation and Tools CD-ROM bundled with each switch contains the 
complete Document Set for AT-8800 Series switches and their expansion 
options, as well as tools for switch management. This includes:

■ The AT-8800 Series Statutory and Safety Information booklet, which includes 
important safety information and statutory declarations for AT-8800 Series 
switches.

■ The AT-8800 Series Quick Install Guide, which outlines the procedure for 
installing switch units.

■ The AT-8800 Series Software Reference, which provides detailed information 
on configuring the switch and its software.

■ AT-TFTP Server for Windows, for downloading software releases.

■ Adobe Acrobat Reader, for viewing online documentation.

These documents can also downloaded from our website at
www.alliedtelesyn.com/support/software .

Contacting Us

With locations covering all of the established markets in North America, Latin 
America, Europe, Asia, and the Pacific, Allied Telesyn provides localized sales 
and technical support worldwide. To find our representative nearest you, visit 
Allied Telesyn on the web at www.alliedtelesyn.com.
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